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NEWSLETTER OF THE LONG ISLAND MACINTOSH RS GROUP

LIMac was estab-
lished in 1984, when
the Mac was intro-
duced. Annual dues for
membership is $26.
First meeting is free.
For information,
contact any of the
following:

Membership

Donald Hennessy
(516) 541-3186
aboutlimac @ aol.com

Technical Advice
Bradley Dichter

(631) 348-4772
bdichtere cdr.net
Program
Coordinator

Richard Matteson
rickgm @ earthlink.net

Photoshop SIG
Norman Kashefsky
(516) 783-7836
captword e earthlink.net

Beginners SIG
Geoff Broadhurst
gahoofeaol.com

Internet SIG
Al Choy
achoy e villagenet.com

The FoRUM is pub-
lished monthly by
LIMac. All contents,
except where noted,
are copyright ©20001
by LIMac. Opinions
expressed are the
views of the authors
and do not necessarily
reflect those of LIMac.
Contents may be
reprinted for non-
commercial use, with
due acknowledgment
to LIMac. The LIMac
ForuM is an indepen-
dent publication and
has not been author-
ized, sponsored or
otherwise approved by
Apple Computer, Inc.

Produced using:
Tex-Edit Plus, Adobe
InDesign, Photoshop,
Illustrator, Acrobat
and Freehand.

November’s Meeting

Linden Harding,
who dubs himself
the “Epson
Evangelist,” pre-
sented the latest in
Epson printers and
scanners at the

October’s Meeting
October meeting.

is Epson considers this

year “ayear of product advancement.”

He began with a short summary of the
principles of scanning technology. Epson’s
latest is the Expression 1680, a flatbed with
1600 dpi and 48-bit professional capability
with xenon lamps for color accuracy. There
is a transparency stage available as an option.
Matrix CCE technology reduces the signal
to noise ratio. It uses a staggered system.

A continuous flow of RGB information is
maintained. In the simpler Epson scanners
pixels are processed simultaneously for better
quality.

The ink jet printers from Epson are called
the Stylus Photo series. Epson was the first
with FireWire, the tirst with USB, The low
end Stylus is 780 and the 890. The 780 has six
colors, borderless prints and is only $99. The
1280 replaces the 1270. It is a large format
printer (!) —and is a step below the 3000. The
1280 is considered the best for digital photog-
raphy. Inks are all dye-based and produce a
true black. Epson claims a smoother dot pat-
tern, an important quality in facial tones. The
new C80 has individual ink cartridges. It is
possible to replace only one color. &

— Joan Bernhardt

Who is this man and what is he doing?
You’ll find out what he’s holding; what it does;
and when you’ll be able to get it on Page 2.

This month’s meeting
will feature a guest
speaker from
Olympus who will
show five of their
newest digital cameras
and two photo
printers. Camera models will include the Five-
megapixel E-20N, an update of the E-10
Professional SLR; the C-3020, a 3.2-megapixel
zoom with point-and- shoot presets or full
control options; the C4040, a 4.1-megapixel
zoom with Super Bright 1.8 lens; the D-230,
a two-megapixel pocket size model; and

the D-40, a four-

megapixel, ultra compact zoom.

Beside discussing each model’s unique
features, he’ll demonstrate the new Auto-
Connect USB drag-and-drop function built
into each model, and the lastest Camedia soft-
ware that makes it easy to create, show and
share your photos and images.

Sample prints, hands-on demos, product
literature, and answers to your questions
should make this an informative night! &
—Rich Scillin
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Friday, Novmber 9th, 7 p.m. at Anna
Rubin Hall (Building 300), The New York

Institute of Technology, Old Westbury.

The Internet SIG: Held at the Bethpage Public Library, (516) 931-3907,

on the third Monday (November 19th) of each month at 8 p.m.

Multimedia SIG: Will try to have a meeting late in November. The date is
uncertain as of publication time, but Bernie Flicker (twoflickereaol.com ) will
notify all those who send him their e-mail addresses.

SIGs immediately after the general meeting:

Beginners SIG: Begins at9 p.m.

Mac Help SIG: Just what it says.

DTP/Photoshop SIG: Will continue series of National Association of
Photoshop Professionals training videos. This month’s topic is “Amazing
Photoshop Shortcuts.” These videos are full of useful and time-saving
tips. Don't forget your notebook!

Theobald
Sl <LIMac meetings, unless otherwise
frittersi noted, are held in Building 300

(Anna Rubin Hall) at the New York
Institute of Technology on Northern
Boulevard in Old Westbury, L.I.

» In bad weather, call (516)
686-7789.

» The next LIMac board meeting will
be at the Plainedge Library, (516)
735-4133, on Wednesday, November
14th, at 8 p.m.
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Bill Medlow
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Making a Boot CD
by David Nagel

So, now you've gone and done it. You lost your orig-
inal CD. It was a good thing you made a backup.
But your backup won't boot. Here’s what you do.

» Insert the non-bootable CD into your CD-ROM
drive and a blank CD into your CD recorder.

» Launch Toast and select Files and Folders from
the little pull-down menu on the main screen.

» Click the Data
i Data... | button. A dialog box
will pop up that
says, Drag files and folders to this area. Don’t do
1 - that. Instead, click
e s New CD. Then name
el # your CD whatever
you want. Remember, the name will be permanent.
» Click the button called Add. Another dialog box
appears asking you to pick your file or folder.

Select the whole CD and click Add and then Done.
This will create a subfolder on your new CD with the
name of the CD you're copying.

» Move the System Folder out of the subfolder and
onto the root level of your new CD.

» Next, the most important step: Create a new

I L) folder at the root
‘_" 'fy level of your new

i I7= — CD called Desktop
Folder. You can’t boot from a CD without adding

this folder manually. Just click New Folder and
change the name of the new folder that’s created
from Untitled Folder to Desktop Folder.

» Finally, just click Done and write your CD. To
start up off this new CD, place it into your internal
CD-ROM drive and restart the computer. Press and
hold down the “C” key on your keyboard right after
you hear the startup sound. &

(Your license only allows you to create one copy for
backup. Destroy the non-bootable one.)

Bill Medlow
President
ArchBill@aol.com
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Equipment Stress?:
Some people believe
that turning equipment
on and off (for
example, once each
day) can, over a long
period, put stress on
equipment. They
argue that equipment
should be left on,
whether in energy-
saving sleep mode or
not. Others believe
that leaving equipment
turned on makes it
more vulnerable to
power fluctuations,
which could put stress
on equipment and be-
lieve that equipment
should be turned off
when not in use.

With equipment
that is Energy Star
compliant in areas
where there are no
issues with the
quality or depend-
ability of power, turn
off equipment if it is
going to be idle for
eight hours or more.
For idle periods of
less than eight hours,
use Energy Saver
software to optimize
energy usage.

-Mid-Columbia Mac
User Group (The
Finder)

President’s Message

Technical Corner

It will be impossible to forget

about 9/11/01. It is a tragic

date that we should never

want to forget. President Bush

and Mayor Giuliani have told

us that we must move forward

and, based on some recent events

involving Anthrax and e-mail,
computers should become even more neces-
sary. And so our upcoming general meetings
will have greater emphasis on answering these
needs and securities.

Our meetings, including the Q&A session,
are a forum for the exchange of ideas and
information. This communication benefits all
members and is our priceless asset.

Remember those that were injured or died,
and all the families whose lives have been
changed as a result. &

(User Group News from Page 4)

labels, holiday gift tags, CD/DVD labels,
newsletter templates and more. All the designs
are in AppleWorks documents with text

frames ready for your personal information.
Paper Designs for AppleWorks lists for $99.95.
However, Macintosh user group members can
buy the product for only $29.95 (plus $5 ship-
ping and handling) directly from AWUG. &

Steve Jobs introduces Apple’s MP3 player,
the iPod, on October 23rd.

Featuring 5GB HD storage (21000 songs),

a ten-hour battery and twenty-minute anti-
skip protection — all wrapped in stainless
steel while still weighing only 6.5 ounces —
and seamless integration with ¢Tunes 2 via
FireWire. It should be available for $399 on
November 10th, in time for Christmas. See
www.apple.cog/ipod/ for details. &
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» I have two FireWire hard drives con-
nected to my G4 Cube, daisy chained
together. If I don’t have the first one on,
the Mac doesn’t recognize the other one. Is
that the way it is supposed to work?

Yes. Without power, the FireWire interface
cannot pass signals through it like most SCSI
peripherals could. I’'m assuming you have a
digital camcorder in one of the two FireWire
ports on the Cube itself. If you must, keep
the first drive off. Then, if they both have two
FireWire connectors, just switch them around
so that the most used one is first. If you can
arrange it, based on the assumption you need
the main FireWire hard drive on all the time
and the second hard drive only sometimes
and the digital camcorder also only some-
times, plug one hard drive in to the first
FireWire port and the digital camcorder into
it, and the other hard drive into the other on-
board FireWire port. Then both hard drives
get first crack at the Mac. Otherwise, I sug-
gest a FireWire hub might be useful here.
Belkin and others make them with up to six
ports. (Approx. $50—$90)

» I have the CD-ROM disc that came with
the retail Mac OS 10.1. Do I have to upgrade
my Mac OS 9.0.4 first to 9.1 to upgrade to
9.2.1}

No. You can go directly to 9.2.1 with that CD.
It has an installer, not just an updater. The
Mac OS 10.1 update comes with a 9.2.1 updater
on CD. That updater requires first the Mac OS
9.1 update to be installed on your 9.0.4 Mac.
If you don’t have it, it’s free, but a 89MB file
to download. Of course, on top of all this
you may have to update some stuff to work
with 9.2.1. Like Conflict Catcher, TechTool Pro,
PopChar Pro, etc.

» Any known problems upgrading from
Mac OS 9.1 to 9.2.12 T have a Sonnet G4
upgrade.

There were some initially, but they have been
resolved since with downloadable updaters.

1 can recall DiskWarrior 2.1.1, PopChar Pro
1.3.3, Conflict Catcher 8.1, TechTool Pro 3.0.5
and there were some minor shareware updates
that addressed 9.2.1 also. (Disk First Aid
Downbler 1.0.2) There may be other new prob-
lems that might turn up, since it comes with
CarbonLib 1.4. Sonnet only claims Mac OS 9.1
compatibility with their latest software release
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Bradley Dichter
bdichteracdr.net
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Why are monitors
degaussed?
Computer monitors
and other video
screens that use a
cathode-ray tube can
sometimes display
distorted colors and
images caused by a
buildup of magnetic
energy especially near
the corners of the
screen). Degaussing,
which is often an
option on the moni-
tor’s controls removes
the problem.
Magnetic forces
outside the monitor
can cause magnetic
disturbances within
it, leading to the dis-
tortion of images on
the screen.
(External forces can
be anything from
novelty magnets
placed too close to
the monitor to the
natural magnetism
of Earth.)
Degaussing your
monitor helps move
the effects of the
external magnetism.
Most current monitors
will automatically
degauss themselves
when you turn on the
screen. You can also
buy external
degaussing devices.
-J. D. Biersdorfer


http://www.apple.com/ipod/

PC-Formatted Zip
Disks and 0S X :

If you've mounted a
PC-formatted Zip disk
on your Mac running
0S X, you can not
save directly to that
disk from an open
Classic application. In
other words, you can
use the Save dialog
box within a Classic
application to save
that file to Zip disks
formatted in this way.
Instead, you must
save the file to your
hard disk and then
copy the file to the
Zip by drag-and-drop.
Likewise, you can't
use a Classic appli-
cation’s Open dialog
box to open files

on PC-formatted Zip
disks. Again, you must
first copy these files to
your hard drive before
opening them.

Find Your Friends
(For both Mac 0S 9.1
and 0S X users.):

If you've ever lost

the phone number of
an old friend or
wanted to look up the
address of your long-
lost cousin Jack, the
Web site www.anywho
.com is for you. This
Web site allows you

to look up a person’s
phone number - even
if you're not sure
where he or she lives.
Just type in all the info
you know and it'll do
the rest. You can also
look up businesses
and perform a reverse
lookup, wherein you
(See Right Column)

More Technical Corner

back in July. Based on the software’s upgrade
history, I don’t see that Mac OS 9.2.1 should
trip up their software relative to Mac OS 9.1,
so you should be OK with a few downloads.

» In AppleWorks 6.1.2, the default font is
Times but when I make a text box it comes
in Geneva.

The default font is primarily for the Apple-
Works Word Processor. What you need to do
for the text boxes in the drawing mode is

to select the Text Tool and before drawing a
box, select your desired font and size and style
from the Menu Bar. Then, every new text box
you draw will use that font.

» In AppleWorks, there is a Recent Items
starting point but it never seems to stop.
What can I do?

Two choices. First Control-click on the item
you wish to remove and select Remove
Starting Point from the Contextual Menu. Or
second, you can delete them in greater num-
bers by quitting AppleWorks, opening your
Documents folder, opening the AppleWorks
User Data folder, opening the Starting Points
folder and then the Recent Items folder. There,
you can trash anything (just a bunch of
Aliases) you don’t want. Then, you can start
up AppleWorks again. It will keep remem-
bering items forever unless you clean it up like
this. The File menu also keeps a shorter list of
recently used files. Here, you have some con-
trol. Go to the Edit menu, select Preferences >
General. There, from the Topic: pop-up menu,
Files. There, you can change the number of
Recent Items (Remember the last XX opened
Documents — File menu.) and change XX to
something normal like 5 or 10. Or, uncheck
the check box to turn off this feature entirely,
— it will not effect the Starting Points.

» Outlook Express has a growing collection
of deleted files in my Deleted Files folder. Is
there a global way of getting rid of them?
The best way is to edit the schedules so that
the empty deleted items schedule is performed
at quit. Go to the Tools menu, select Run
Schedule > Edit Schedules. Double-click on
Empty Deleted Items Folder and change the
When pop-up menu to On Quit and click the
OK button and close the Schedules window.
You can still, if for some reason you have a
need to, select Tools > Run Schedules > Empty
Deleted Items Folder to empty the Trash on

demand now, rather than wait until you

quit the program. While you were editing
schedules, I usually set the Send and Receive
All schedule to run at startup (of Outlook
Express). By the way, Microsoft’s Entourage
part of Office 2001 works the same way.

» What would you recommend for a
FireWire CD burner to go with my
FireWire PowerBook?

Yamaha’s $330 20x Lightspeed2 recorder
model # CRW2200FXZ is the best now ship-
ping and there is a $30 rebate now until
11/11/01. It wins all the editor’s awards.

Buy it in conjunction with Roxio’s Toast 5
Titanium software. Upcoming is the better
and faster CRW3200FXZ, also for $330, which
will be far better for audio CDs as it

will have Yamaha’s exclusive Audio Master
Ouality Recording System and the “Pure

Phase Laser System. See http://news.excite.com/
news/pr/011011/ca-yamahba-audio-recrd for a
comprehensive press release about my next
recorder. Make sure you buy some quality
blank CDs. Yamaha, of course, recommends
their 20X or new 24X certified CD-Rs. Audio
CD’s are usually recommended to be 74
minute for compatibility with the widest
range of players, but the audio CD-Rs only
are rated at 16X Max. Don’t buy inferior
products like Memorex brand. Toast Titanium
comes with a limited edition of Magic Mouse
Productions’ Discus CD labeling program. You
can check out www.magicmouse.com about the
$20 full version upgrade for more included
artwork. It has templates for all the major

CD adhesive labels for your printer. By

the way, avoid buying and burning those busi-
ness card-sized CD-R (called CardDiscs), as
they will get stuck in a slot loading iMac,
PowerBook G4 or iBook.

» I have a couple of folders in my trash that
formerly had photos in them. The folders
are empty but I can’t delete them. I’ve
tried the Option key and starting up with
Extensions Off.

This is a sign of directory damage. Try
starting up off of the System CD and running
Disk First Aid or better yet if you have

it, Norton Disk Doctor, TechTool Pro or
DiskWarrior. There was a 1991 shareware pro-
gram called HellFolderFix but I don’t think it
would work on a Mac OS Extended volume. &
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type in a phone
number and the site
will give you all the
information about
that number. Try it out
and see who you can
find.
Convert Just About
Anything (for both
Mac 08 9.1 and
0S X users):
If you deal with image
files, and most of us
do, then you know how
painful the process
can be sometimes.
Graphic Converter to
the rescue! This appli-
cation will convert just
about any image
format to any other
image format. You can
browse image folders
as slide shows and in
a drop-down, Finder
type mode. Graphic
Converter is now
Carbonized and ready
for 0S X. Go get
version 4.0.5 from
WWW.versiontracker.com
and you'll be on the
road to better image
control.
An Excitahle
Assistant? is a nice
little addition to your
Classic system:
Head to www.excite
.com and sign up
for a free account.
Then download the
assistant. When you
click the assistant,
you are instantly
updating news,
weather, stocks, and
other information in
a small resizeable
window. It’s like
having a PalmPilot on
your screen. When
opened, it places a
small tab on the side
of your screen. Try it
out and see what you
think.
-THE FINDER of Mid-
Columbia Mac Users
Group
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Sore Eyes

User Group News

Well! We installed the new Mac OS X.1. It

has many advantages: It works. It is faster.

It is smooth. It is fun. We even installed it

on Shel’s new iBook, along with OS 9.2.some-
thing or other. By the way, that system is also
faster and more stable than OS 9.1.

Before I go further, let me inform you
that you can get OS X.1 (the upgrade) by just
going into a store and asking for it. Of course
CompUSA in New York didn’t have it in stock,
but keep trying — they’re really giving it away.
If you can’t be bothered, you can get it from
Mac-Up-To-Date — $20 shipping and handling.

Things I like: The dock. I moved it to
the left side, so it’s more familiar than at
the bottom. Most of my applications work
smoothly.

My printer, an Epson PhotoStylus 2200 is
connected with a USB connector. I bought
it recently because it’s supposed to scan trans-
parencies. Epson has not yet produced a
driver. Promises, promises. First it was going
to deliver when Apple produced OS X.1. Now
the new delivery date is November 5. So I
write my docs in OS X, because I like it, and
save them to the Desktop, go to 0§ 9.2 and
print in Word.

I do not yet have VirtualPC working the
way I would like it. That will take a bit more
time. I also lost AOL Instant Messenger when 1
went from OS X to OS X.1

Just one more thing bothering me now:
To use File Sharing, I must first boot up the
other computer and get the address (thanks
to Verizon). This may be solved when our
son, the consultant, comes for Thanksgiving
to rewire our entire setup. He doesn’t like the
way it is. This is supposed to be solved when
he puts in the new Airport Base Station. 1
hope so. More comments to follow. &

At our October 12th general meeting the
LIMac membership voted unanimously to
increase dues from $26 to $36 per year, begin-
ning January 2002. The Board of Directors
wishes to thank the membership for for its
overwhelming support on this matter. We
will begin collecting dues for 2002 at the
November general meeting. Make your check
payable to LIMac Inc. For those members that
cannot attend the November meeting you can
mail in your check to our post office box. Just
look for the return address on this issue of
the Forum.

We want to remind members that LIMac’s
financial records are open to inspection by any
member. All you need to do is ask and we will
gladly comply with your request.

In November, we will have our annual
election of officers and Olympus will be
our featured presenter. We are currently
getting ready for our year-end party in
December, and are looking for some help in
organizing for this event. Please see Max at
the November meeting if you are able to vol-
unteer. Also, start thinking about the goodies
that you will bring to the party.

MUG Store Web site: www.applemugstore
.com. Passwords from 11,/01,/2001 to 12/31/
2001 — User ID Pro/Password: create AWUG
(the AppleWorks User Group) www.awug.ory.
(888) 781-AWUG; Fax: (734) 454-1965 for
Paper Designs for AppleWorks and includes
designs for matching letterheads, envelopes,
certificates, appointment cards, business cards,
name badges, mailing (See page 2)

If your $26 dues check is overdue, bring to a
meeting or mail it to: Long Island Mac Users
Group, P.O.Box 2048, Seaford, NY11783-2048
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Max Rechtman
MaxLIMaceaol.com

Download PDF files:
If you have an Acrobat
plug-in for your Web
browser, then you
know that when you
click on a PDF linkin a
Web page, instead of
downloading the PDF,
it opens inside your
browser. Sometimes
this can take a while if
itis a large document,
and you may not even
want to look at it
right then. To down-
load the PDF to your
hard drive rather than
have it open in your
web browser, press
the Option key when
clicking the PDF link.
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